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Pelatihan Membuat Presentasi Menarik Dengan Infografis 

 

Apa itu Infografis? 

Infografis adalah cara mempresentasikan atau penyajian data dengan konsep visual yang 

terdiri dari teks dengan tambahan gambar-gambar ilustrasi yang menarik. Secara umum hasil 

akhir dari sebuah infografis mempunyai prosentase gambar visual yang lebih banyak 

dibandingkan informasi teks. Tujuan utamanya adalah orang dapat memahami dengan cepat 

dan jelas akan sesuatu yang disampaikan. Hal ini dapat diwujudkan karena aspek visual grafis, 

yang akan memberikan ketertarikan, penekanan dan pemahaman yang mudah. 

 

Manfaat Mengikuti Training Infografis: 

Membantu Anda untuk menciptakan daftar data/informasi/knowledge yang akan digunakan 

sebagai sumber bahan infografis. 

Menyajikan visualisasi data dengan baik 

Mampu menyederhanakan data dengan logis dan akurat, sehingga mudah dipahami oleh 

audiens 

Membuat audiens memahami data dengan cepat 

Media visual marketing paling efektif 

Mampu Mempengaruhi audiens meng-iya-kan informasi yang disajikan dalam bentuk visual 

 

Materi Utama 

-Content  : Membuat materi presentasi dengan rapi, logis dan terstruktur 

-Design :  Bagaimana membuat slide presentasi dengan visual yang baik dan maenarik 

-Delivery : Bagaimana membawakan presentasi bisnis dengan menyakinkan 

 

 

http://itgid.org/training
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Overview Materi : 

 

Konsep Infografis 

Definisi Infografis 

Manfaat inforgrafis 

Jenis-jenis Infograsi 

Infografis Statis 

Infografis animasi 

Infografis interaktif 

Five steps to Infographics 

Toolbars yang digunakan untuk infografis 

Merubah teks menjadi bentuk visual seperti gambar 

Merubah data menjadi cerita dalam animasi 

Infographic webware, bagaimana menggunakan infogr.am, picktochart.com, prezi.com,dll 

Membuat infografik bergerak 

Teknik-teknik modern menggunakan bagaimana membuat Infografik bergerak menggunakan 

Powerpoint—temasuk meng-import charts dari MS Excel dan memberi animasi yang unik dari 

fitur Custom Animation 

Slide presentasi menggunakan prezi,  

Study Kasus 

 

 Methods Pelatihan : 90% Praktik. 

http://itgid.org/training


How to Make 
Infographics with 
Powerpoint 
 
When you first hear the word “infographic,” your immediate thought is unlikely to 
be “PowerPoint.” In fact, many people are completely unaware you can create 
great infographics with powerpoint. And yet, it’s an incredibly useful tool that comes 
with fully customizable options and does not carry any expense, as it’s a program 
most people have. There’s no need to get (or to learn!) Photoshop, nor subscribe 
to any of the infographic-creating software options that tend to come with a hefty 
price tag. 
Many content creators avoid infographics for this very reason: They tend to be 
time-consuming, frustrating, or expensive to create. Another option is to outsource 
your infographics to professionals and let them do the creating for you. But if you’re 
looking for a great DIY option, PowerPoint provides a surprising and highly 
effective option that will allow you to create quality, original infographics to 
complement your content marketing strategy. 

Why Should You Use 
Infographics? 
Infographics have many large benefits, as they allow you to present your 
information in a user-friendly manner that’s effective and succinct. Whatever your 
topic, it’s possible to present it in the form of an infographic. In fact, providing an 
infographic is a brilliant way of conveying it in the easiest way possible. 
Infographics are more readily shared than written content alone tends to be, and 
they do incredibly well on image-based social media platforms such as Pinterest. 
The statistics on visual content are impressive. Eighty percent of text-based 
content is forgotten as soon as it’s read, while infographics are read 30 times more 
than the same information in text format. You’ll also enjoy a 12 percent boost in 
traffic after publishing an infographic. Sixty-five percent of people are wired to learn 
visually. Add to this the fact that it will do wonders for your SEO by providing 
multimedia content, then there are loads of great reasons to make infographics. 

http://www.copypress.com/infographics-interactive-media-products/
http://www.copypress.com/infographics-interactive-media-products/
https://blog.hubspot.com/marketing/visual-content-marketing-strategy?__hstc=156880356.feb18e157eeb70e42133d022d85bca2f.1523341353802.1523341353802.1523341353802.1&__hssc=156880356.1.1523341353802&__hsfp=1962557905
https://www.fastcompany.com/3035856/why-were-more-likely-to-remember-content-with-images-and-video-infogr


How to Make 
Infographics with 
PowerPoint 
Creating infographics in PowerPoint is surprisingly simple. The only limit is your 
patience and imagination. Even the more advanced techniques are 
straightforward, and there are many premade and easily customizable elements 
to get you started. We’ve put together a super simple, eight-step guide to making 
infographics using PowerPoint. 
Before we dive in, note that exactly how you change settings and use certain 
controls may vary slightly depending on your version of PowerPoint. This 
example was created in PowerPoint 2013. 

 
Original graphic courtesy of Hazel Butler for CopyPress 

Step 1: Create A Portrait 
Slide 
Begin with a blank presentation and a new slide. The default in PowerPoint is for 
landscape slides. You will need to change this. Navigate to the Design tab and 
click “Slide Size” followed by “Custom Slide Size.” This will cause a dialogue box 
to appear. Change the orientation of your slide to “Portrait” and add custom 
measurements: 

https://www.copypress.com/wp-content/uploads/2018/05/PP1.jpg


 
Original graphic courtesy of Hazel Butler for CopyPress 
It’s recommended you make the image 6 inches wide by 14 inches tall to get 
started. However, remember that different platforms have different size 
requirements, so consider where you want to share your infographic when deciding 
on the size. 

Step 2: Format the 
Background for Your 
Infographic 
Next, you will want to give your infographic an interesting background. There are 
a few ways to do this. The simplest way is to select an attractive theme from the 
Design tab, allowing PowerPoint to set your background and the complementary 
colors for you: 

 
Original graphic courtesy of Hazel Butler for CopyPress 
The other way to do it is manually by navigating to the “Format Background” option 
on the far right of the Design tab. Clicking this option will display a dialogue box 
that gives you a few different options, including setting a background image from 
an uploaded file of your choice and creating gradient options: 

https://www.copypress.com/wp-content/uploads/2018/05/PP2.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP3.jpg


 
Original graphic courtesy of Hazel Butler for CopyPress 
You can combine these two functions by setting a theme that will automatically 
ensure your fonts and colors are complementary and then adding a custom image 
to the background. 

Step 3: Edit Your Title and 
Subheading 
The slide will default to a standard format, including title and subtitle elements. You 
can edit the text in each and move them to the area of the infographic you want 
them in. Putting them at the top is usually a good idea, but you might want to play 
around with your designs and see what looks best: 

 
Original graphic courtesy of Hazel Butler for CopyPress 

Step 4: Add New Elements 
Using SmartArt 

https://www.copypress.com/wp-content/uploads/2018/05/PP4.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP5.jpg


Before we get into more complex functions, let’s run through using SmartArt to 
insert responsive elements. There are many ways to add custom shapes, charts, 
and vector graphics when creating infographics with PowerPoint. However, the 
SmartArt application provides an easy way of adding a wide range of items that 
looks amazing and is effortless to create: 

 
Original graphic courtesy of Hazel Butler for CopyPress 
Go to the insert tab and select “SmartArt”; then choose the type of element you 
would like to include. You can play around and have fun, as there are many 
options. It’s fully possible to create everything else needed for a truly dynamic 
infographic using nothing but SmartArt. Pick one to start with and click “OK”: 

 
Original graphic courtesy of Hazel Butler for CopyPress 
You can also select the design variation you prefer from the options displayed at 
the top of your screen: 

 
Original graphic courtesy of Hazel Butler for CopyPress 
Click on your graphic to edit the text elements and add your original content: 

 
Original graphic courtesy of Hazel Butler for CopyPress 
Finally, select the color you would like to use from the “Change Color” option. If 
you selected a theme when choosing your background, your elements will all 
default to theme colors. If not, you will need to choose them manually, and you 
can tweak colors even if you have a theme in use: 

https://www.copypress.com/wp-content/uploads/2018/05/PP6.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP7.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP8.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP9.jpg


 
Original graphic courtesy of Hazel Butler for CopyPress 

Step 5: Create Unique 
Elements Using Shapes and 
Text Boxes 
While the SmartArt options are extensive, you may also find there are certain 
things you want to create that don’t have a preset option that will work. To do this, 
you can combine shapes with text boxes to create completely unique features for 
your infographic. Go to the Insert tab and select “Shapes.” Then choose from the 
wide range of shapes on offer: 

 

https://www.copypress.com/wp-content/uploads/2018/05/PP10.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP11.jpg


Original graphic courtesy of Hazel Butler for CopyPress 
Once your shape has been inserted, use the options that appear at the top to 
choose your color. You can use one of the preset options or the “Shape Fill” and 
“Shape Outline” options to select custom colors. You can also use the “Shape 
Effects” function to make your shape a little more dynamic: 

 
Original graphic courtesy of Hazel Butler for CopyPress 
Once you have your shape looking exactly as you want it, add a text box by going 
to the Insert tab and choosing “Text Box.” You can add multiple text boxes and 
tweak the fonts, sizes, and colors, and then move them around so they are 
arranged as you want them over your shape.: 
  

 
Original graphic courtesy of Hazel Butler for CopyPress 
When you’re happy with how all your text boxes and shapes look together, select 
every part of the new element you have created, including the shape and all your 
text boxes, by clicking on each in turn while holding shift (the control may be slightly 
different, depending on the computer or device you’re using!). You should end up 
with all aspects of your unique element selected. When you’re sure you have 
selected every aspect, right click over the selected elements; then click “Group” 
and select “Group” again: 
  

https://www.copypress.com/wp-content/uploads/2018/05/PP12.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP13.jpg


 
Original graphic courtesy of Hazel Butler for CopyPress 
This will link all aspects of your newly created element together. Now when you 
click on it, you will find it is selected as if it were a single element rather than 
several. This is especially useful because you can then move it around easily 
without losing your alignments. 
If you need to duplicate your new element, simply select it once it’s been 
grouped, copy and paste it, and then tweak the text and colors so you have 
matching unique elements: 
  

 
Original graphic courtesy of Hazel Butler for CopyPress 

Step 6: Add Original Images 
to Create Complex Elements 
Another great way to ensure your infographics are completely unique to your brand 
is to add original images. You might use photographs (particularly if you have 
brand photographs), or choose relevant icons or graphics. Whatever you use, it’s 
a good idea to add images to your elements to make your infographic as visual 
and engaging as possible. There are two ways to do this: 
You can use the Insert tab to add an image as you have added shapes and text 
boxes and combine your images with both in exactly the same manner we used in 

https://www.copypress.com/wp-content/uploads/2018/05/PP14.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP15.jpg


step 5. The easier way, however, is to take advantage of SmartArt elements that 
include images. Go back to the SmartArt function and insert a new element that 
includes images; edit it, as we did in step 4; and then click on any of the empty 
image icons: 

 
Original graphic courtesy of Hazel Butler for CopyPress 
A dialogue box will appear, giving you various options for choosing a source for 
your image. Find the file you want to use and insert it. Repeat this as many times 
as necessary to replace all empty images with custom images. This will help you 
create dynamic elements for your infographic: 

 
Original graphic courtesy of Hazel Butler for CopyPress 

Step 7: Optimize the Layout 
of All Your Elements 
Continue adding elements to your infographic until you have all the information on 
it that you want and everything is formatted to your liking in terms of images, fonts, 
and colors. Once you have everything on your infographic, play around with the 
layout until everything is presented in the most logical and visually pleasing way. 
You may find there are elements you have inserted using SmartArt that work better 
if you move around their various aspects. This is useful for making them a little 
more unique and also for fitting things in: 

 

https://www.copypress.com/wp-content/uploads/2018/05/PP16.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP18.jpg
https://www.copypress.com/wp-content/uploads/2018/05/PP19.jpg


Original graphic courtesy of Hazel Butler for CopyPress 
Remember, one of the benefits of creating infographics with PowerPoint is that 
you can always return to “Custom Slide Size” in the Design tab to change the 
dimensions of your infographic if you find you have too much or too little space. 

Step 8: Save Your 
Infographic 
Once you’re happy with your infographic, go to “File,” click “Save As,” and select 
the file type you’d like your infographic to be in. PowerPoint will default to saving it 
as a presentation, but you can select various different file types from the dropdown 
list. You can publish your infographic to a PDF; however, your file will be more 
versatile in JPG or PNG format. There’s no reason you can’t save it in multiple 
formats, so you have different versions for platforms that have different 
requirements. 
When you click “Save,” PowerPoint will ask if you want to save the whole 
presentation or just the one slide. Select the slide. 
The end result is an image file that looks great and can be uploaded anywhere: 

 
 
Original graphic courtesy of Hazel Butler for CopyPress 

 
 

https://www.copypress.com/wp-content/uploads/2018/05/PP20.jpg


Design for Value and 
Impact 
Remember, there’s more to creating an infographic than using the tools needed to 
create the visual. Like any piece of content, your infographic should be designed 
for maximum value and impact. The one created for this post is simple, so as to 
show you how to create the basic elements. However, there are no limits to the 
infographics you can create once you’ve learned how to do them. 
Plan your infographic carefully. Think of a catchy, attention-grabbing headline, and 
follow it up with a compelling subheading. Arrange your information so it flows and 
has a clear narrative, even if only to the extent that facts and text are laid out in the 
most logical order. Use original design elements, such as your logo and brand 
photographs, and customize every aspect of your infographic so it aligns with your 
brand colors, fonts, and the general look and feel. 
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INFOGRAFIS  

VISUALISASI INFORMASI DAN DATA 
BERBASIS GRAFIS  

Infografis/infographic berasal dari bahasa Inggris 

information + graphic.   

• Graphic diterjemahkan menjadi grafis, seni visual yang 
berkaitan dengan gambar dan huruf. Sedangkan 
infografis mengacu pada visualisasi grafis yang 
menunjukan relasi satu atau beberapa data atau 
informasi tertentu.   

Infografis/infographic berasal dari bahasa Inggris 

information + graphic.   

• Secara umum diartikan sebagai teknik penyajian 
informasi secara visual/grafis, sehingga lebih mudah 

dipahami  oleh pembaca. Elemen grafis 
digunakan sebagai upaya untuk 
mempersingkat informasi tanpa mengurangi 

kejelasan dari informasi tersebut. Bahasa yang 
digunakan pun biasanya bahasa yang mudah 
dipahami oleh masyarakat pada umumnya.  

Infografis/infographic berasal dari bahasa Inggris 

information + graphic.   



         INFOGRAFIS  

• Hasil akhir dari infografis lebih didominasi bentuk 
visual daripada informasi teks. Proses pembuatan 
infografis disebut information design, 

datavisualization, dan information architecture.  

Penggunaan simbol-simbol  grafis yang universal disertai 
bahasa dan teks yang sedikit, Memudahkan komunikan 
(pembaca) memahami informasi yang terkandung dalam 
infografis tersebut.   

Tujuan  
Tujuan infografis sama dengan public speaking.  
Tujuan infografis adalah untuk menginformasikan, 

menghibur, dan mempersuasi pembaca sehingga 

pembaca memberikan perhatian (membaca), 

menyimpulkan dan melakukan aksi seuai dengan 

informasi dalam infografis tersebut.   

  

Jenis-Jenis  

Infografis statis   

• Infografis yang dibuat dalam bentuk visual statis atau 
gambar yang tidak bergerak. Jenis infografis ini adalah 
jenis paling umum digunakan dalam menyampaikan 
informasi dalam berbagai kebutuhan, diantaranya 
media cetak dan hasil-hasil penelitian.  



 

  



 

 



 

INFOGRAFIS / Jenis-Jenis  

Infografis animasi  

• Infografis yang menyajikan informasi dalam bentuk 
audio video. Infografis jenis ini bisa disajikan dengan 
dua atau 3 dimensi yang telihat lebih kompleks, 
misalnya televisi dan youtube.  

Jenis-Jenis  

Infografis interaktif  

• Infografis yang dibuat pada sebuah website agar 
pengguna dapat berinteraksi dengan informasi yang 
ditampilkan. Untuk membuat jenis infografis ini 
biasanya dibutuhkan seorang desainer, UI/IUX 
disainer, illustrator, dan programer.  



INFOGRAFIS /  

  

• http://infographicworld.com/interactiv e - infographics /   

• http://www.simplybusiness.co.uk/microsites/hungr y - tech /   

• http://www.informationisbeautiful.net/visualizations/world s - bigges t - dat a - breache
hacks/http://www.informationisbeautiful.net/visualizations/world s - bigges t - dat a - breache
hacks /   

• etc   

  

http://infographicworld.com/interactive-infographics/
http://infographicworld.com/interactive-infographics/
http://infographicworld.com/interactive-infographics/
http://infographicworld.com/interactive-infographics/
http://infographicworld.com/interactive-infographics/
http://www.simplybusiness.co.uk/microsites/hungry-tech/
http://www.simplybusiness.co.uk/microsites/hungry-tech/
http://www.simplybusiness.co.uk/microsites/hungry-tech/
http://www.simplybusiness.co.uk/microsites/hungry-tech/
http://www.simplybusiness.co.uk/microsites/hungry-tech/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/
http://www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/http:/www.informationisbeautiful.net/visualizations/worlds-biggest-data-breaches-hacks/


 

Elemen-elemen  

• Material,  berupa data atau informasi atau 
pengetahuan yang akan menjadi isi dari visualisasi 
informasi.  

• Kreator, berupa perangkat lunak (software) yang 
akan mendukung pembuatan infografis.  

• Elemen Visual, berupa koding warna, grafis, teks 

(typografi).  

  

  

  



 

 



INFOGRAFIS / infographics process  

1. Memilih Topik  

Mencari tahu apa yang sedang menjadi 

trending topic di berbagai media, atau 

mencari tahu informasi seperti apa yang 

akan diolah menjadi infografis  

2. Melakukan survey dan riset  

Mencari sumber-sumber data dari 

bukubuku, internet, dan sumber lainnya.  

3. Mengumpulkan data dan informasi 

Memilah-milah berbagai data dan 

informasi yang diperoleh (yang 

diperlukan).  

4. Menganalisis data  

Menganalisis, mempelajari, membaca dan 

mengartikan data dan informasi yang 

diperoleh.  

5. Membuat narasi  

Membuat narasi, membangun cerita 

berdasarkan analisis data yang dilakukan  

6. Membuat sketsa/wireframe  

Brainstorming, membuat berbagai sketsa 

visual   



INFOGRAFIS / infographics process  

7. Editing  

engedit format dan menyusun tampilan 

data untuk dimuat ke dalam visualisai  

8. Desain  

Mengintegrasikan elemen visual yang 

telah disusun  

9. Melakukan pengujian  

Melakukan validasi terhadap data dalam 

visualisasi  

10. Penyempurnaan  

Melakukan perbaikan berdasarkan hasil 

pengujian  



 

 



 

Cara membuat infografis  

Cara susah membuat infografis adalah dengan 

menggunakan software-software desain grafis, 

diantaranya:  

✓ Adobe Illustrator  

✓ Adobe Indesign  

✓ Adobe Photoshop  

✓ Adobe Flash  

✓ Adobe Premiere  

✓ Adobe Dreamweaver  

✓ CorelDraw  

✓ Corel Photopaint  

✓ Quark Xpress  

✓ Microsoft Excell  

✓ Microsoft Publisher  

✓ Dan lain-lain  

cara membuat infografis  

Cara mudah membuat infografis adalah dengan 
memanfaatkan layanan-layanan online yang khusus 
dibuat untuk memproduksi infografis.  
✓ Picktochart (www.picktochart.com)   

✓ Easely (www.easely.ly)   

✓ Visme (www.visme.co)   

http://www.picktochart.com/
http://www.easely.ly/
http://www.visme.co/


 

✓ Canva (www.canva.com)   

✓ Infogram (www.infogr.am)   

✓ venngage (www.venngage.com)  

✓ Icharts (www.icharts.net)   

✓ Statsilk (www.statsilk.com)   

✓ Tableu public (public.tableu.com)   

✓ Creately (www.creately.com)  

✓ iconarchive (www.iconarchive.com  

✓ Many Eyes  

(http://manyeyes.alphaworks.ibm.com/manyey

es/)  

✓ Inkscape (https://inkscape.org/en/)   
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